Table of Contents

1 Where Can This Script Be Used? 3

2 Demo Story: SAP Portfolio and Project Management 1.0 for SAP S/4HANA 4
2.1 Review Item Dashboard and Bucket Structure 5
2.2 Create New Proposal Item 7
2.3 Detailed Assessment of New Proposal Item 11
2.4 Review and Release of New Proposal Item 17
2.5 Project Planning 24
2.6 Staffing via Resource Manager 30
2.7 Authorizations, Project Release, and Baseline 33
2.8 Task Management and Time Recording 37
2.9 Project Monitoring 45
2.10 Portfolio Monitoring 49
2.11 Decision Point Closing 53
2.12 Project Phase Closure 54

Document History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>&lt;2019-04-15&gt;</td>
<td>Release for customer</td>
</tr>
</tbody>
</table>
1 Where Can This Script Be Used?

This demo script has been written for usage with the SAP S/4HANA 1809 Feature Package Stack 02 (FPS02) Fully-Activated Appliance (in short “appliance” in this script), hence you will need such an appliance to make use of this guide. The appliance can be brought up in two ways, and the demo scenario in this script is largely the same for both:

1. Via SAP Cloud Appliance Library (hosted on cloud providers)
   You need a cloud provider account at AWS, MS Azure, or GCP. With this, you can deploy the appliance within 1-2 hours from https://cal.sap.com > Solutions > SAP S/4HANA 1809 FPS02 Fully-Activated Appliance.

2. Via installing it on your own on-premise hardware.
   You need to provide your own hardware, and order & install the appliance as explained in SAP Note 2041140.

If you are new to the SAP S/4HANA Fully-Activated Appliance, introductory information can be found here: https://blogs.sap.com/2018/12/12/sap-s4hana-fully-activated-appliance-create-your-sap-s4hana-1809-system-in-a-fraction-of-the-usual-setup-time/

Important:
Before you start your demo, please read SAP S/4HANA Fully-Activated Appliance: Demo Scripts for information about necessary preparations, especially any post-deployment steps to ensure the full functionality of your appliance. Besides this, you will also find links to all demo scripts on this page.
Demo Story: SAP Portfolio and Project Management 1.0 for SAP S/4HANA

This demo script leads you through a typical end-to-end process for managing projects in S/4HANA. In this scenario the example of an IT Project is used to showcase the solution capabilities, but you can manage also other types of projects such as R&D projects, capital and maintenance projects or customer projects with this solution.

The process starts in portfolio management where the user will create a project request providing information about expected timeframe and financial and capacity demands for the future project. In a review session stakeholder will evaluate and rank multiple project proposal against each other using questionnaires and scoring methods. Based on the results the user will approve the project proposal which will lead to the creation of an operational project in project management.

Here the project manager starts with planning and scheduling of detailed project tasks and with specifying the required project roles. A resource manager reviews the resource demand for this project and assigns a named resource out of his resource pool. Before the project manager releases the project for execution he sets the authorizations in the project and creates a baseline version, which is later used to compare actuals vs. planned values.

Project team member can find the tasks that they are assigned to in the “My Task List” app. During the project execution phase each member of the project can record his time spent on the project which will then be automatically transferred to the finance module and leads to actual costs in the financial planning of the portfolio item. With that project management as well as portfolio manager can closely track the progress and costs performance of the projects.

With approving the last decision point and generating the project status report the project is closed and locked against further changes.
2.1 Review Item Dashboard and Bucket Structure

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Fiori Launchpad and log on as a Portfolio Manager. <strong>User:</strong> S4H_PPM_PFM <strong>Password:</strong> Welcome!</td>
<td></td>
</tr>
</tbody>
</table>

Navigate to the Portfolio Management group and choose the **Portfolio Items** app.

The **Portfolio Items** view shows a list of all existing items.

Choose **Standard View** from the **View** dropdown list.

Select different views to display, filter, and sort Portfolio Items.

Choose **Home** to return to the dashboard.

Navigate to the Portfolio Management group and choose the **Buckets** app.

This structure represents the hierarchical structure of the portfolio planning.
What to Do | What You Will See
---|---
Choose the **Bucket Structure** tab to display the hierarchal structure of the portfolio planning.

Choose **Home**.

Navigate to the **Portfolio Classification** group and choose the **Classification Hierarchies** app.

Expand the Classification Hierarchy structure to display the alternative structure of the portfolio planning.

Choose **Home**.
2.2 Create New Proposal Item

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Fiori Launchpad and log on as a Portfolio Manager. <strong>User:</strong> S4H_PPM_PFM <strong>Password:</strong> Welcome1</td>
<td></td>
</tr>
<tr>
<td>Navigate to the Portfolio Management group and choose the Portfolio Items app.</td>
<td></td>
</tr>
</tbody>
</table>

Choose the Create dropdown button and choose Create Item.

Choose Select Bucket.

Expand IT Innovation.

Choose Infrastructure and choose OK.
### What to Do

Make the following entry and choose **Continue**:

**Item Type:** IT Project

### What You Will See

#### Make the following entries and choose **Save**:

**Item Name:** *Choose your own name*

*In this scenario we will use:*

**Edge computing devices deployment**

**Item ID:** IT_IN_0X

*(OX is an ongoing ID)*

- **Forecasted Start and Finish Date:** 01.01.2019 – 31.12.2019
- **Planned Start and Finish Date:** 01.01.2019 – 31.03.2020

Choose the **Miscellaneous** tab and choose **Add**.
**What to Do**

To Add Authorizations for User, make the following entries and choose Assign:

**User:** S4H_PPM_PM  
**Write:** <select>  
**Person Responsible:** <select>

Choose Save.

In the Documents and Notes tab, choose New Document.

Make the following entries and choose either Check In or Check In As URL:

**File:** <File Title>  
**Description:** <Your description>

In the General Information tab, change the Status to In Progress.

Choose Proposal.
<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the <strong>Overview</strong> tab, change the <strong>Status</strong> to <strong>In Progress</strong>.</td>
<td>![Image of the Overview tab with Status changed to In Progress]</td>
</tr>
<tr>
<td>Choose <strong>Save</strong>.</td>
<td>![Image of the Overview tab after saving]</td>
</tr>
<tr>
<td>Choose <strong>Refresh</strong> to see the decision point change.</td>
<td>![Image of the Overview tab after refreshing]</td>
</tr>
<tr>
<td>Choose the <strong>User</strong> button. Log yourself out by choose <strong>Sign Out</strong>.</td>
<td>![Image of the Sign Out dialog]</td>
</tr>
<tr>
<td>Confirm your decision.</td>
<td>![Image of the Sign Out confirmation dialog]</td>
</tr>
</tbody>
</table>
# 2.3 Detailed Assessment of New Proposal Item

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
</table>
| Open the Fiori Launchpad and log on as a Project Manager. **User:** S4H_PPM_PM  
**Password:** Welcome1 | ![Login Screen](image1.png)  
*User:* S4H_PPM_PM  
*Password:* Welcome1 |
| Navigate to the Portfolio Management group and choose the My Portfolio Items app. | ![Portfolio Management](image2.png)  
My Portfolio Items app is open. |
| Choose your new item. A new window will appear showing the details of that item. | ![New Item Window](image3.png)  
New item details are displayed. |
| In the Overview tab, choose Additional Information. Choose the Questionnaire button in the Probability Technical Success field. | ![Overview Tab](image4.png)  
Additional Information and Questionnaire fields are visible. |
Make the following entries and choose OK:

**Product Fits Business Strategy:** Excellent Fit
**Product Leverages Core Competencies:** Highly
**Meets market criteria for functionality:** Highly
**Meets market criteria for usability:** Highly Usable (Minor Issues)
**Market provides growth opportunity:** Yes
**Product is technically feasible:** Yes..It is

---

Make the following entries and choose OK:

**How long has client been in business:** greater than 7 years
**Clients business practices:** 90
**Clients market share:** 70
**Competition in clients marketplace:** 20–50 competitors
Choose the Questionnaire button in the next to Assessed Risk field.

Make the following entries and choose OK and choose Save:

Product is technically feasible: Yes..It is
Product is commercially feasible: Yes..It is
Product forecasted for technical success: Possibly (outsourcing may be needed)
Are current facilities adequate for product development: Yes
Are current personnel adequate for product development: Yes
Product forecasted for commercial success: Yes, projected sales > cost to produce

In the Overview tab, choose Classification.

Make the following entries and choose Save:
Category: IT
Group: Customer Request
Area: EMEA
Location: Germany

Choose Capacity Information.
Choose Capacity Planning.
Expand **Forecasted Resources and Internal IT**.

**What to Do**

- Maintain Capacity Planning for the internal IT resources by entering values for the required capacity for the months.
- Choose Save.

**What You Will See**

- A new window displays.

Expand **Non-HR Forecasted Costs and Internal Costs**.
Enter **10,000** for first 3 periods of the administration costs and confirm your entries. Press enter.

**What to Do**

**What You Will See**

Expand Planned Savings/Revenue and Revenue.

Enter **58,000** in every period and press enter.

Choose Save.

Close the Financial Planning Window
**What to Do**

Choose **Financial Information**.

Choose **Refresh**.

Check the calculated financial KPIs.

Choose **Proposal** to open decision point.

A new window displays.

Make the following entry and choose **Save**:

**Status: Ready for Decision**

Choose **Refresh** to see the decision point change.
### 2.4 Review and Release of New Proposal Item

**What to Do**

Open the Fiori Launchpad and log on as a Portfolio Manager.
*User: S4H_PPM_PFM*
*Password: Welcome1*

Navigate to the **Portfolio Reviews** group and choose the **Reviews** app.

**What You Will See**

![Portfolio Reviews app](image)
What to Do | What You Will See
--- | ---
Choose **IT Review**.

In the **Items** tab, choose **Add**.

Choose **Find**.
Choose the item with an ID of **IT_IN_0X** and choose the (>) Add button to add the item to the Selected Objects section.

Choose **OK** and choose **Save.**
Choose **Scoreboard**.

In the **Scoreboard** view, make the following entry:

**Scoring Model: NPV Score**

Close the scoring window.

Choose all the items.

Choose **Reporting Cockpit**.
Familiarize yourself with the results of the reporting.
Use the table and the graphic to compare the items.
Close the reporting window.
In the View dropdown field, choose Project Prioritization.

Open your item by choosing on the link in the table "Your new item".

In the Item: Edge computing devices deployment view, make the following entries:

Create Project on Saving: <Check>
Project Management Template: IT Project Template
Choose **Save**.

Choose **Proposal**.

In the **Decision Point: Proposal** view, change the **Status** field to **Approved** and choose **Save**.

Close the window.

Choose **Refresh** to see the decision point change.
### 2.5 Project Planning

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Fiori Launchpad and log on as a Project Manager. <strong>User:</strong> S4H_PPM_PM <strong>Password:</strong> Welcome1</td>
<td></td>
</tr>
<tr>
<td>Navigate to the Project Management group and choose the Projects app.</td>
<td></td>
</tr>
<tr>
<td>Choose the Project IT_IN_0X by choosing on the Project (Number) or Project (Description)</td>
<td></td>
</tr>
</tbody>
</table>
To staff yourself as the project manager, choose the **Resources** tab→ choose **Details** → and choose **Staffing**.

Choose the **IT Project Manager** as a **Role (Resource)**.

Make the following entry and choose **Staff**: **Resource:** Peter Project Manager
<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose <strong>Save</strong>.</td>
<td>To create a task within the existing project structure, choose the <strong>Structure</strong> tab→ choose <strong>Detail</strong></td>
</tr>
<tr>
<td></td>
<td>Choose on the <strong>▼</strong> button to collapse the phase in the project structure tree.</td>
</tr>
<tr>
<td></td>
<td>Choose <strong>Create Task</strong></td>
</tr>
<tr>
<td>What to Do</td>
<td>What You Will See</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>In the Structure tab, choose Detail.</strong></td>
<td><img src="https://example.com/image1.png" alt="Image" /></td>
</tr>
</tbody>
</table>
| Choose the Basic Data tab and make the following entries: **Name:** *Create Project Plan* | **Task Type:** Tasktype [01]  
**Responsible Role:** IT Project Manager  
| |  |
| **In the Structure tab, choose Detail.** | ![Image](https://example.com/image2.png) |
| Choose Dates and Work and make the following entries: **Duration:** 10  
**Work:** 8 | **In the Structure tab, choose Detail.**  
**Choose Roles.**  
Mark the row *IT Knowledge Manager* and choose Assign Role.  
Unmark the *IT Knowledge Manager*.  
Mark the row *IT Project Manager* to choose this role. Mark the resource *Peter Project Manager* and choose Assign Resource.  
Enter <1> & <2> person days in the Work column. |
What to Do | What You Will See

Choose Save.

To update the demand of the role **IT Project Manager** according to the project planning, go to tab Resources → Details → General

Mark the role **IT Project Manager** and choose Update Role According to Tasks and see how the **Total Demand** raises by 8 (days work from the task planning)

To create a relationship with another task, go to tab Structure → Detail → Relationships.
What to Do | What You Will See

Make the following entries to create a relationship with task Technical Requirements:  
**Task (Same Level):** Technical Requirements  
**Relationship Type:** Finish-start relationship

Choose Predecessor to define the task Technical Requirements as predecessor.

Choose Save.

Choose on the **Structure** tab to get a better overview of the time planning through the Gantt chart.

**Note:** This Gantt chart is java based and will only be supported by Internet Explorer.

Close the window.

Choose the **User** button.  
Log yourself out by choose **Sign Out**

Confirm your decision.
2.6 Staffing via Resource Manager

Open the Fiori Launchpad and log on as a Resource Manager.

*User: S4H_PPDM
*Password: Welcome*

Choose the Resource Overview app.

Choose the button to expand the Resource *Peter Project Manager*.

Now you can see the following:

- All projects where Peter Project Manager is staffed on
- The Total Availability, Remaining Availability and Total Assigned Effort for each period of Peter Project Manager
- The assigned effort within each project

Note: Here you see the overview of all resources assigned to the current resource pool.
**What to Do**

Choose the **Home** button.

Choose the **Staffing Overview** app.

Choose **IT PROJECT PORTFOLIO** as your Views.

**Note:** Here you see the overview of the staffing status of all projects assigned to the Resource Manager.

Choose the **button to expand the project **Edge computing devices deployment** and expand the **Role IT Knowhow Manager**.
What to Do

To staff a resource to the role IT Knowhow Manager, choose the button and select Assign Resource.

In the Staffing Overview view, choose the row Tina Team Member and choose the button to choose the selected resource.

Choose OK.

Choose Save.

Choose the Home button.

Choose the User button.

Log yourself out by choose Sign Out

Confirm your decision.
# 2.7 Authorizations, Project Release, and Baseline

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Fiori Launchpad and log on as a Project Manager.</td>
<td><img src="image1.png" alt="Image of Fiori Launchpad" /></td>
</tr>
<tr>
<td><strong>User:</strong> S4H_PPM_PM</td>
<td><img src="image2.png" alt="Image of User and Password" /></td>
</tr>
<tr>
<td><strong>Password:</strong> Welcome1</td>
<td><img src="image3.png" alt="Image of Change Password" /></td>
</tr>
<tr>
<td>Navigate to the <strong>Project Management</strong> group and choose the <strong>My Projects</strong> app.</td>
<td><img src="image4.png" alt="Image of Project Management Group" /></td>
</tr>
<tr>
<td>Choose the project tile of <code>&lt;Your new item&gt;</code> within the <strong>Planned Projects</strong> card.</td>
<td><img src="image5.png" alt="Image of Project Details" /></td>
</tr>
</tbody>
</table>
What to Do
Choose the Structure tab and choose Authorizations.

Make the following entries and choose Assign:

User: BPINST
Authorizations: Admin
Evaluate: <Select>
Accounting: <Select>
Resource Management: <Select>
Staffing Manager: <Select>
Candidate Manager: <Select>

Choose Save.

In the Basic Data tab, change the Status field to Release.

Choose Save.
What to Do

Choose the **Structure** tab and choose your project in the project tree.

Change the **Status** of the Project to **Flag for Transfer**.

Choose **Save**.

**Note**: This flags the project for transfer to ERP. On save an PS Project is created. This is a prerequisite for the next step the time recording.

**Make sure that the Phase** **Project Preparation** **as well as the Tasks Kick-Off, Technical Requirements, IT Project Preparation and Create Project Plan** have the Status **Released – Transferred – Assigned**

Choose the **Accounting** tab and choose **Account Assignment**. Check the WBS Structure.
### What to Do

To create a project baseline, choose the tab *Project Versions ➔ Snapshots.*

### What You Will See

**Choose Create.**

Make the following entry and choose **Continue:**

**Version:**

**Z_SNAP_VERSION1**

Choose **Save.**

Choose the **Home** button.

Choose the **User** button.

Log yourself out by choose **Sign Out**

Confirm your decision.
2.8 Task Management and Time Recording

What to Do | What You Will See
--- | ---
Open the Fiori Launchpad and log on as a Team Member. **User:** S4H_PPM_Tm **Password:** Welcome1
Navigate to the **Project Tasks** group and choose the **My Tasks** app.
Choose on a task that has already begun (Planned Start is before your current date)
What to Do

Note: Check all the details. Here the team member can find more information on what is to be done.

What are the figures for dates and works. The information could have been stored as an attachment or a description.

Choose Confirm.

Choose Edit.

Type in a value for Done Since Last Confirmation and a Percentage

Choose Save.

Choose the Home button.
What to Do

Navigate to the Project Checklist Items group and choose the My Checklist Items app.

Choose on a checklist item that has already begun (Planned Start is before your current date)

Note: Check all the details. Here the team member can find more information on what is to be done. What are the figures for dates and works. The information could have been stored as an attachment or a description.

Choose Edit.
What to Do | What You Will See

Make the following entries and choose **Save**:

**Change Status:** Release.

**Result:** OK.

**Change Status:** Finish.

Choose the **Home** button.

Preconditions for successful time recording

- Make sure you have assigned the user **BPINST** as Admin to the project **IT_IN_01**. This is described in Step **Obtain further authorizations** in section Authorizations, Project release and Baseline.
- Make sure you have created the task **Create Project Plan** and that you staffed the role **IT Knowledge Manager** to this task.
- Make sure you have assigned **Tina Team Member** to the role **IT Knowledge Manager**.
- Make sure you have released the task **Create Project Plan**.

The team member must record their times to the task. Therefore, enter the **My Timesheet App** in the **Time Recording** section.

**Note:** There are two possible ways for Time Recording. In this demo the new Fiori App **My Timesheet** was enabled!

Choose the day on the calendar when you want to record the times.

Choose **Create**.
Choose the (Search Help) of the field Select Favorite or Worklist
In the upcoming pop-up you can choose the task that you have created earlier.

Enter the Duration <8> And optionally, a Note <Note>

Move to area Time Assignment
Make the following entries:
(Feel free to use the search help.)

Activity Type: A000 (8)
Controlling Area: Controlling Area A000 (A000)
Sender Cost Center: A000 (17101301)

Choose Submit.
Confirm the submission and choose OK.
**What to Do**

The time was successfully recorded.

**Note:** Every full hour the Job PPM_Service is scheduled. This job updates the recorded times to PS, Project Management and renew the Financial Planning Views in Portfolio Management. You can monitor this Job with Transaction SM37.

**Optional:** Record Times with Transaction CAT2

You can skip the next steps and sign out in case you successfully recorded times with the My Timesheet app.

**Optional:** The team member must record his times to the task. Therefore, he enters the Time Recording Transaction in the Time Recording section.

Make the following entries:

**Data Entry Profile:** ZMCRDPPM

**Personnel Number:** 20

**Note:** 20 is the Personnel Number of Tina Team Member. Choose Enter Times.
Choose a Task from the Worklist. The task Create Project Plan should be available.

Choose More → copy row.

Or, Press F5 on your keyboard.

In the Data Entry Area section, make the following entries:
- **Sender Cost Center:** 17101301
- **Controlling Area:** A000
- **Activity Type:** 8
- **Sending Functional Area:** YB40

Scroll to the right.

- **Receiving Functional Area:** 0001

Scroll further right

- **Unit of Measure:** H

Insert <8> hours into the period columns.
### What to Do

Choose **Save**.

**Note:** Every full hour the Job "PPM_Service" is scheduled.

This job updates the recorded times to PS, Project Management and renews the Financial Planning Views in Portfolio Management.
You can monitor this Job with Transaction **SM37**.

Choose the **Home** button.

Choose the **User** button.
Log yourself out by choose **Sign Out**

Confirm your decision.
2.9  Project Monitoring

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
</table>
| Open the Fiori Launchpad and log on as a Project Manager.  
**User:** S4H_PP_M_PM  
**Password:** Welcome1 |
| Navigate to the Project Management group and choose the My Projects app. |

Choose the tile My Projects → Active → View All.

Mark the project New Project Co-Pilot Function and choose Project Progress.
### What to Do

Choose the **Expand** button in the line of the phases or zoom in/out to get an overview of the project progress.

### What You Will See

Choose the **Home** button.

Choose **Projects**.

Choose a project from the list. Choose the **Project (Number)** or **Project (Description)**.

Choose **Print Fact Sheet**.

Choose **Preview** to generate a PDF Fact Sheet.
What to Do | What You Will See

Printing and Downloading is available within the integrated PDF viewer.

Choose **Item**

Choose **Financial and Capacity Planning → Financial Planning**

Check the Actual Costs.
This ALV should display the Actual HR Costs for Efforts that were recorded by the Team Member Tina Team Member. (The recorded hours are converted via cost rate)
Adjust the **Period Displayed** and choose **Apply**.

Close the window and choose **Financial and Capacity Planning → Capacity Planning**
What to Do | What You Will See
--- | ---
The capacity planning displays the Actual Person Days for Efforts that were recorded by the Team Member Tina Team Member.

Choose the Home button.

Choose the User button.

Log yourself out by choose Sign Out

Confirm your decision.
### 2.10 Portfolio Monitoring

<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Fiori Launchpad and log on as a Portfolio Manager. <strong>User:</strong> S4H_PPM_PFM <strong>Password:</strong> Welcome1</td>
<td><img src="image" alt="Log On" /></td>
</tr>
<tr>
<td>Navigate to the Portfolio Management group and choose the Portfolio Items app.</td>
<td><img src="image" alt="Portfolio Items" /></td>
</tr>
</tbody>
</table>

Choose the View drop-down list and choose *Standard View*.

Select different views to display, filter and sort Portfolio Items in different ways, e.g. Project Overview.

Choose Home.
What to Do  What You Will See

In the Portfolio Management section, choose Buckets.

Choose a Bucket Name.

Choose Financial and Capacity Planning and choose Financial Planning.

In the Financial Planning: IT Innovation view, choose Include Subobjects to display the items related to the bucket cost.
Choose **View Chart** and choose your desired view to Display Chart Reports of the Financial Bucket Planning.

Close the window and go back on your Bucket. Choose **Financial and Capacity Planning** and choose **Capacity Planning**.
<table>
<thead>
<tr>
<th>What to Do</th>
<th>What You Will See</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Capacity Planning of the bucket is shown.</td>
<td></td>
</tr>
<tr>
<td>To display the items related to the bucket cost choose on <em>Include Subobjects</em>.</td>
<td></td>
</tr>
</tbody>
</table>

To Display Chart Reports of the Capacity Bucket Planning choose *View Chart* at the top and select the desired view.
2.11 Decision Point Closing

Open the Fiori Launchpad and log on as a Portfolio Manager.  
**User:** S4H_PPM_PFM  
**Password:** Welcome1

Choose *Portfolio Items* and choose a Portfolio Item.

In the *Phase and Decisions* tab, choose the *Created* Decision Point.
Change the Status from Created to In Process.

Change the Status from in Progress to Ready for Decision.

Choose Save at the bottom of the page.

Afterwards you can change the Status from Ready for Decision to Approved.

Choose Save.

The Decision Point Planning is locked, and the Decision Point Execution is activated.

2.12 Project Phase Closure

Open the Fiori Launchpad and log on as a Project Manager. 

User: S4H_PPM_PM
Password: Welcome1
Navigate to the Project Management group and choose the My Projects app.

Choose a project item.

Choose the phase Preparation
Choose Complete Subordinates
Accept the pop up.
All tasks within this phase are being completed.

In the Basic Data tab, change Status to Completed.
This phase is completed.
Choose **Save**

Go to the next Phase *Business Blueprint* and change the *Status* of the phase into **Release**.

Choose **Save**.